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Reflective Memo: Usability Testing Report on Microsoft Word – Mixed-Level Tasks 

Overview 

This project was carried out at the University of New Mexico's Zimmerman Library between 

June 22 and June 24, 2025. This formative usability test evaluated Microsoft Word’s usability 

among three international students (19–21 years old) at UNM’s CELAC program, representing 

beginner to intermediate proficiency levels. The test was conducted in-person at the Graduate 

Commons using Word 365 and employed a think-aloud protocol with pre- and post-test 

questionnaires. It focused on six formatting/collaboration tasks (e.g., headers, Track Changes) to 

identify pain points in feature discoverability and workflow efficiency. The purpose of the test 

was to bridge gaps between Word’s complex interface and diverse users’ needs, aligning with 

Rubin’s usability principles and Norman’s design theories. 

Theoretical Framing 

The overall approach including design, execution, and reporting of this usability test were deeply 

informed by principles from usability testing, user-centered design, and technical and 

professional communication (TPC). Rubin and Chisnell’s Handbook of Usability 

Testing provided the foundation for structuring the test as a moderated, task-based session with a 

triangulated data collection method (Ch. 6 - 8). To capture both user expectations and 

satisfaction, I included both pre- and post-test questionnaires in line with Rubin's emphasis on 

measuring both baseline knowledge and user satisfaction (Ch. 14). In analyzing participants 

struggles, Donald Norman’s The Design of Everyday Things contributed significantly, 

particularly through the concepts of “the gulf of execution” and “signifiers,” which helped 

diagnose why users hesitated or misunderstood interface cues. Finally, Robin Williams’ Non-

Designer’s Design Book (Ch. 10 - 13) informed the layout and instructional clarity of the test 
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document, emphasizing simplicity, contrast, and alignment to reduce visual clarity and cognitive 

strain for users. 

Testing Group Assembly 

Considering various demographic factors such as age, gender, and tech-savviness, I selected a 

testing group that was both diverse and precise. All three participants were international students 

from UNM’s Center for English Language and American Culture (CELAC), ranging in age from 

19 to 21. Their MS Word experience ranged from beginner to intermediate, with gender balance 

and varied educational backgrounds. I chose this mix intentionally to explore how different 

levels of digital literacy and previous exposure influenced task performance. 

Test Execution: Successes and Struggles 

The usability test was conducted over three days in a quiet setting using Microsoft Word 365 on 

Windows 10 laptops. Running the test involved guiding participants through a series of 

structured tasks. Participants were guided through a standardized set of six tasks, with a 

moderator providing task prompts and encouraging think-aloud responses My successes included 

smooth facilitation and engaging participants effectively, resulting in rich verbal feedback. 

However, challenges during testing included participants skipping key steps, misinterpreting the 

wording of tasks, or relying on their usual habits instead of trying out new features in the 

interface. While I used audio recordings for notetaking, no screen recordings were done due to 

consent limitations 

Data Analysis and reporting 

The analysis was both rewarding and challenging. Success was found in identifying clear trends 

and actionable insights from user feedback. Logging quantitative metrics such as task completion 

and error rates were easy, but understanding qualitative feedback required close review of notes 
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and audio recordings. Using Norman’s framework helped connect users’ actions to how they 

were thinking, while Rubin’s focus on using multiple types of data made it easier to confidently 

identify usability problems.	Writing the report involved a balance between clear storytelling and 

thorough analysis. Structuring results by task and connecting each to specific participant quotes 

helped demonstrate patterns and provide strong evidence for the final recommendations. 

Reflection on Learning  

This usability test showed how important it is for the design of a program to match what users 

expect. Beginners didn’t struggle because they weren’t trying, but because the user-interface 

didn’t clearly show how things worked. For example, finding the Track Changes feature or 

merging table cells was harder than expected, even though those are basic tasks. Doing this test 

helped me see how small design choices can have a big effect on how people learn and work. 

Conclusion  

For me, this project put the core tenets of user-centered design and usability theory into practice. 

Rubin’s structured test planning, Norman’s insights into user cognition, and Williams’ visual 

design principles collectively shaped the methodology and outcomes of this project. Connecting 

this project to key theories while staying responsive to the lived experiences of actual users, I 

learned not only how to test usability, but how to advocate for more thoughtful and accessible 

technology design. This reflection confirms that theory and practice go hand in hand in the field 

of technical and professional communication. 
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Usability Test Plan for Microsoft Word Mixed-Level Tasks 

Introduction 

Purpose 

This test plan outlines the methodology for assessing the usability of Microsoft Word’s 

formatting, layout, and collaboration features among users with varying levels of experience. The 

primary aim is to evaluate user interaction and identify usability issues. The overall goal is to 

identify pain points in feature discoverability, workflow efficiency, and user satisfaction, aligning 

with Rubin’s usability metrics and Norman’s principles of design. The test will help identify 

usability challenges and areas where interface or instructional improvements are needed. 

Scope 

The test assesses how users with varying experience levels navigate and utilize Microsoft Word’s 

features focusing on Rubin’s concept of learnability and Norman’s gulf of execution to assess 

where the interface supports or hinders user goals. 

Objectives 

• Evaluate how users locate and use key 
formatting and collaboration features 

• Assess learnability (Rubin) for 
beginners 

• Identify obstacles in interface 
navigation, especially for beginner 
users. 

• Identify gulfs of execution (Norman) 
in multi-step tasks (e.g., table 
merging). 

• Evaluate signifiers (Norman) for 
feature discoverability. 

 
• Collect qualitative and quantitative 

feedback to improve Microsoft 
Word’s usability 

• Provide actionable recommendations 
for UI improvements. 

 

Research Questions/Hypotheses 
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• How do beginner users compensate for unfamiliar or unclear UI components? 

• Do users of different skill levels complete the same tasks with equal success? 

• Are formatting and collaboration tools (e.g., Track Changes) discoverable without 

instruction? 

Methodology 

This formative usability test would be conducted in-person with the support of a moderator. 

Participants would complete six structured tasks using a pre-made Microsoft Word document 

while following a think-aloud protocol. Initial and Follow-up (pre- and post-test) questionnaires 

would be used to assess user background and perception. Screen recording would be done per 

participants’ preferences. Observations, written notes, audio notes, and follow-up questionnaire 

would be used to capture performance, hesitations, and feedback.  

Test Type 

This would be a formative usability test conducted with a moderator guiding participants through 

common Microsoft Word tasks. The goal would be to identify usability issues and gather 

feedback on how users interact with Word’s interface, particularly where they struggle or get 

confused. Unlike performance-based tests, by observing users in real-time, the study would focus 

on qualitative insights observing where users hesitated, made errors, or needed help.  

Participants 

• Target Users: 3 participants with mixed expertise (beginner, intermediate). 

• Recruitment: Non-random sampling; prioritize diversity in age, gender, and Word 
proficiency. 

• Inclusion Criteria: Familiarity with Microsoft Word. 

Test Setting 
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The sessions would be conducted in-person at the Graduate Commons in Zimmerman Library 

using Windows 10 laptops with Microsoft Word 365. Participants would complete the test in a 

controlled environment using Microsoft Word 365 on Windows 10 laptops. 

Test Materials 

• Microsoft Word 365 on Windows 10 laptops 

• Initial and Follow-Up (pre-and post-test) questionnaires 

• Task script 

• Printed moderator script 

• Test Word document 

Test Design 
• Type: Formative, moderated usability test (Rubin Ch. 5). 

• Approach: Task-based with think-aloud protocol (Rubin Ch. 6). 

• Data Triangulation: Combine quantitative metrics (task success, time) with qualitative 
insights (observations, quotes). 

Scenario 

Participants would act as a Writing Group members as they plan to join the group to learn and 

improve writing mechanics. As they are not very much into writing, I want to know their 

familiarity and prior experience of using MS Word.  

Tasks 
Task Number Description Objective 
Task 1 Add a header with your name 

and date 
Assess basic navigation 

Task 2 Change the font style and size Evaluate text styling ease 
Task 3 Apply heading 1 and heading 

2 styles 
Text document structuring 
skills 

Task 4 Insert and customize 3X3 
table 

Examine table manipulation 
skills 

Task 5 Insert a hyperlink to a 
university website 

Check hyperlink insertion 
awareness 
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Task 6 Use Track Changes to edit a 
sentence and add a comment 

Assess collaborative editing 
features 

 
Data Collection 

Metrics Instruments Analysis Plan 
Performance Subjective 
Task Succes 
rate (binary) 

Post-task ratings 
(ease/difficulty) 

Initial (pre-test) 
Questionnaire: 
Demographics, 
computer literacy, 
Word experience 

Quantitative: Compare 
success rates/time across 
proficiency levels 

Time-on task Emotional responses 
(frustration/satisfactio
n). 

Follow-Up (post-
test) 
Questionnaire: 
task feedback, 
Perceived usability, 
final thoughts 

Qualitative: Code themes 
(e.g., “confusion with Track 
Changes”) 

Error frequency 
(e.g., 
misapplied 
styles) 

Moderator 
Notes: Observation
s, hesitations, 
quotes 

Triangulation: Cross-
reference metrics with quotes 
(e.g., P1’s header struggle) 

Data Analysis 
Quantitative Metrics Qualitative Insights 

Task success rates (binary completion) Think-aloud transcripts  
Time-on-Task: Record duration to complete 
each task 

Post-task interviews  

Error Frequency 
 

Roles and Responsibilities 

• Moderator: Facilitate session, provide task prompts, guide user if necessary  

• Note-Taker: take notes, observe user behavior, document task times and errors 

• Analyst: Synthesizes data into findings/recommendations 

• Participants: Complete tasks, verbalize thought process, answer pre- and post-test 

questions 

Timeline 
Phase Duration 
Planning 1 week 
Recruitment 1 week 
Testing 1-3 days 
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Analysis/Reporting 1 week 
 

Ethical Considerations 
• Consent: Participants give verbal consent acknowledging voluntary participation 

• Privacy: No screen recordings; anonymize data in reports. 

• Incentives: None 

• Withdrawal: Participants can withdraw at any stage  

Deliverable 
1. Test Report: Key findings, severity matrix  

2. Recommendations: UI improvements  

3. Appendices: Initial and Follow-up (pre and post-test) Questionnaires, raw notes. 

Appendices 

• Initial (Pre-Test) Questionnaire 

• Follow-Up (Post-Test) Questionnaire 

• Word Task Document 
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Microsoft Word – Mixed-Level Tasks 

Executive Summary 

This Microsoft Word usability test explored user interaction with several formatting, 
layout, and collaboration features among three users with varying experience levels. Tasks 
included mixed-level functions including applying headers, styling text, inserting and 
customizing a table, creating hyperlinks, and using the track changes features for collaborative 
editing. While all users navigated basic tasks easily, intermediate and advanced tasks highlighted 
discoverability challenges, particularly with table customization, hyperlink, and tracking 
changes. Key recommendations include enhancing interface guidance and reducing steps for 
multi-part tasks like table merging and link insertion. 

Introduction 

Microsoft Word serves as the dominant word processing tool across academic, business, 
and personal contexts, yet its many features quite often create usability challenges for many 
users, particularly for beginner and intermediate users. This test explores how users with varying 
proficiency levels complete six essential but commonly needed formatting and editing tasks, 
with an emphasis on three core usability dimensions: (1) navigation efficiency (Rubin's 
“learnability” principle), (2) workflow interruptions (Norman's “gulf of execution”), and 
(3) feature discoverability (Norman's “signifiers” concept).  

Methodology 

 In this usability test, three participants with varying levels of experience in Microsoft 
Word were asked to complete a series of tasks involving document formatting and collaborative 
editing. An Initial (pre-test) and a Follow-up (post-test) questionnaire were also given to the 
participants. The Initial (pre-test) questionnaire was done to establish baseline proficiency and 
contextualize results (Rubin, Ch. 6), this questionnaire identifies participants’ prior experience 
with Word features, learning preferences, and digital literacy levels critical for interpreting task 
performance through Norman’s “knowledge-in-the-head” principle. Whereas the Follow-up 
(post-test) questionnaire measured perceived usability and emotional responses (Rubin Ch. 14), 
this tool captures immediate pain points (e.g., frustration with table customization, Track 
Changes) and aligns with Norman’s emphasis on evaluating user satisfaction alongside task 
success. 

The study followed a task-based testing approach where the tester being a moderator 
evaluated how effectively participants completed commonly needed formatting and editing tasks. 
The sessions were conducted in-person at the Graduate Commons in Zimmerman Library using 
Windows 10 laptops with Microsoft Word 365. Participants completed the test in a controlled 
environment using Microsoft Word 365 on Windows 10 laptops. The moderator guided each 
session and took notes on participant behavior and task performance. Sessions were not recorded 
owing to permission issues by the participants, but the moderator took notes in abundance both 
in written and audio recorded form for further analysis of interaction patterns and usability 
issues. 
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Participants 

 This test had the goal of testing Microsoft Word usability with participants of varying 
level expertise; therefore, the only requirement for the participants was to be familiar with 
Microsoft Word. Three individuals participated in this test study, representing a range of 
different genders, different age groups, and varying Microsoft Word usage experience. 

 Participant 1. A female, 19 years old, attending UNM’s Center for English language and 
American Culture (CELAC). She is attending Intensive English classes at the center and plans to 
start her freshman at UNM in the fall 2025 semester. She has a beginner-level experience of MS 
Word. 

 Participant 2. A female, 21 years old, attending UNM’s Center for English language and 
American Culture (CELAC). She is attending Intensive English classes at the center and plans to 
start her freshman at UNM in the fall 2025 semester. She has more than beginner-level 
experience of MS Word as she has already used it quite often while doing her undergrad first-
year at her home country.   

Participant 3. A male, 21 years old, attending UNM’s Center for English language and 
American Culture (CELAC). He has moderate level MS Office experience and intermediate 
level familiarity with MS Word. He has already completed an associate degree from his home 
country and have used MS Word for various purposes including writing, resume, cover letters, 
etc.  

Test Setting 

• In-person observation with no screen recording 
• Note taking both written and audio 
• Devices: Windows laptops running Microsoft Word 365 
• Think-aloud protocol used 
• Average test duration: 25–30 minutes 

Data Collection 

 Data were collected during the sessions. Both quantitive and qualitative data were 
collected through a combination of direct observation, note taking, and participant self-reporting. 
Moderator tracked task completion, time on task, and noted any user errors or hesitations. In 
addition, participants completed an Initial (pre-test) questionnaire to provide context on their 
computer and Word experience, and a Follow-Up (post-test) questionnaire to capture their 
perceptions of task difficulty and interface usability. These measures helped triangulate findings 
by combining behavioral data with user-reported feedback. 
Type of Usability Test 
 This was a formative usability test conducted with a moderator guiding participants 
through common Microsoft Word tasks. The goal was to identify usability issues and gather 
feedback on how users interact with Word’s interface, particularly where they struggle or get 
confused. Unlike performance-based tests, by observing users in real-time, the study focused on 
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qualitative insights observing where users hesitated, made errors, or needed help. The goal was 
not to benchmark performance but to inform design and instructional improvements. 
Scenario and Tasks 
 Test Scenario. You work as a Writing Consultant at the Center for Teaching and 
Learning (CTL) of your university. The center aims to provide peer to peer support to the 
students. You are planning to run a “Writing Support Group” during fall 2025 semester. You have 
already initiated an email with different professors, teaching associates, teaching assistants, and 
some department administrators about this writing group. You have been contacted by three 
international students through their center’s teacher who is your friend. The students want to join 
that group to learn and improve writing mechanics. As they are not very much into writing, you 
want to know their familiarity and prior experience of using MS Word.  
 Tasks. Each participant was given a series of tasks to complete. All the participants were 
given a word document and were asked to complete the tasks listed below. Keeping in view the 
participants international background and Initial (pre-test) Questionnaire responses, these tasks 
were chosen because they represented mixed-level challenges for two reasons: I can better gauge 
their skills and familiarity with MS Word and check how good user interface MS Word has.  
 Complete the following series of tasks: 

1. Add a header with their name and the date. 
2. Change the font style and size of a paragraph. 
3. Apply Heading 1 and Heading 2 styles to text. 
4. Insert and customize a 3x3 table (merge cells, adjust column width). 
5. Insert a hyperlink to a university website. 
6. Use Track Changes to edit a sentence and add a comment. 

Data Analysis 

 The collected data were analyzed both quantitatively and qualitatively to identify 
usability patterns across tasks and participants. The collected data, including task success rates, 
time-on-task metrics, and qualitative feedback, were analyzed through triangulation to identify 
recurring usability patterns. This combined approach provides a holistic view of user behavior 
and highlights areas of friction, confusion, or efficiency in Microsoft Word's interface. This 
mixed-method approach aligns with Rubin’s framework for diagnosing both what users 
struggled with and why. 

Results: Task Observations 

Task 1: Add a Header 

• All participants completed the task. 
• P1 took longer to find the “Insert > Header” path. 
• P3 used double-click shortcut at top margin. 

Observation: Beginners are less familiar with shortcuts and tend to navigate through menus 
manually. 
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Task 2: Change Font Style and Size 

• Completed smoothly by all participants. 
• P1 hovered over font names for preview. 
• P2 did use the “styles” pans. 
• P3 used the “Styles” pane and keyboard shortcuts. 

Observation: All participants found the Home tab intuitive for basic text styling. 

Task 3: Apply Heading Styles 

• P1 manually bolded and enlarged the text, skipping styles. 
• P2 and P3 used the built-in Heading 1 and Heading 2 styles correctly. 

Observation: P1 didn’t realize that applying formatting manually doesn’t structure the document 
semantically. 

Task 4: Insert and Customize a 3x3 Table 

• P1 inserted the table but had difficulty merging cells. 
• P2 adjusted width successfully but needed guidance on merging. 
• P3 completed all actions quickly using the Layout tab. 

Observation: Merging cells and resizing columns were non-obvious for novice users; "Layout" 
vs. "Table Design" tabs caused confusion. 

Task 5: Insert a Hyperlink 

• P1did not know nothing of it. She needed guidance. 
•  P2 copied the URL but didn’t use the Insert tab—needed guidance. 
• P3 used “Insert > Link” easily. 

Observation: Beginners expect to paste URLs directly; they may miss formatting options like 
display text or tooltip. 

Task 6: Use Track Changes and Add a Comment 

• P1 couldn’t locate “Track Changes” without assistance. 
• P2 toggled it correctly but forgot to “Accept” the change. 
• P3 completed both tasks with no issues and used Review tab efficiently. 

Observation: Track Changes is difficult to discover and understand for new users. It also 
requires multiple steps (turn on, make edit, accept/reject, add comment). 
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Observation Participant 1 Participant 2 Participant 3 

Header addition Struggled Smooth Smooth 

Font style change Smooth Smooth Smooth 

Heading application Manual format Correct styles Correct styles 

Table customization Difficult Needed help Efficient 

Hyperlink insertion Needed guidance Needed guidance Smooth 

Track Changes usage Needed help Forgot steps Efficient 

Quantitative Metrics: 

• Task success rates (binary completion) and time-on-task were recorded to 
measure efficiency (Rubin’s “performance metrics”). 

• Error frequency (e.g., misapplied Styles, incorrect Merge Cell actions) was logged to 
identify learnability barriers (Norman’s “slips vs. mistakes”). 

Qualitative Insights: 

• Think-aloud transcripts captured decision-making processes, revealing moments where 
users struggled with feature discoverability (e.g., searching for Track Changes in the 
Ribbon). 

• Post-task interviews probed emotional responses (frustration/satisfaction) to align with 
Rubin’s "user satisfaction" framework. 

Triangulation Approach: 

By cross-referencing quantitative metrics (e.g., slow task time) with qualitative data (e.g., 
verbalized confusion about Table Tools), we pinpointed why specific features caused friction, 
addressing Norman’s call to diagnose root causes, not just symptoms. 

Participant Quotes  

Task: Adding a Header 

• P1 (Beginner): 
“I thought the header would be under the ‘View’ tab... I didn’t expect it to be in ‘Insert.’” 

Task: Changing Font Style and Size 
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• P2 (Beginner /Intermediate): 
“Changing font is easy—I do that all the time when I’m writing reports.” 

Task: Applying Heading Styles 

• P1 (Beginner): 
“I just made the text bold and bigger... I didn’t know I was supposed to use something 
called ‘Heading 1.’” 

• P3 (Intermediate): 
“Using heading styles is key for structure and the table of contents—it’s second nature 
for me now.” 

Task: Inserting and Customizing a Table 

• P2 (Beginner /Intermediate): 
“I had to click around to find the merge cell option—it’s not as obvious as I expected.” 

• P1 (Beginner): 
“I was worried I’d mess up the table when I tried to resize it.” 

Task: Inserting a Hyperlink 

• P1 (Beginner): 
“I usually just paste the link—I didn’t know you could change the text that shows.” 

Task: Track Changes and Comments 

• P1 (Beginner): 
“I’ve heard of Track Changes, but I’ve never used it before—took me a while to find it.” 

• P3 (Intermediate): 
“This is my favorite feature. I use it constantly for collaborative editing.” 

Key Findings 

Difficulties were noted in table customization and Track Changes, highlighting the need for 
clearer signifiers and tutorials (Norman, Chapter 1). 

Issue      Severity                           Affected Users 
Track Changes feature difficult to find and use      High                            P1, P2 
Table customization tools not clearly labeled      Medium                            P1, P2 
Manual formatting misused in place of styles      Medium                            P1 
Inserting hyperlinks lacks intuitive entry point      High                            P1 
Inserting hyperlinks lacks intuitive entry point      Medium                            P1 

Recommendations 
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1. Add Smart Prompts for Advanced Tools 
When a user manually formats headings, suggest applying a “Heading style” to enable 
document structure features like TOC. 

2. Simplify Table Customization UI 
Merge cell and layout tools could be surfaced directly when a table is selected (as 
floating tools or quick-access icons). 

3. Improve Track Changes Onboarding 
Include an in-app tip or guided walkthrough when “Review” tab is first opened in a 
document. 

4. Insert Hyperlink via Context Menu 
Enable right-click hyperlink insertion for selected text more prominently for beginners. 

Actionable Steps 

• Design in-app tutorials for complex tasks 
• Conduct user feedback sessions to refine and improve interface changes 
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Appendices 

1. Initial (pre-test) Questionnaire 
2. Follow-up (post-test) Questionnaire 
3. Word Task Document 
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Usability Testing: Microsoft Word 

Initial (Pre-Test) Questionnaire 

Section 1: Background Information 

• 1. Name or Participant ID (optional): ______________________ 

• 2. Age Range: ☐ Under 18 ☐ 18–25 ☐ 26–35 ☐ 36–50 ☐ 51+ 

• 3. Occupation/Field of Study: ______________________ 

• 4. How often do you use a computer? ☐ Daily ☐ Few times/week ☐ Rarely 

• 5. Device most used: ☐ Laptop ☐ Desktop ☐ Tablet ☐ Smartphone 

Section 2: Computer Literacy and Confidence 

• 6. Rate your overall computer skills: ☐ Beginner ☐ Intermediate ☐ Advanced 

• 7. Comfort using new software: ☐ Not comfortable ☐ Somewhat ☐ Very comfortable 

• 8. Formal computer training? ☐ Yes ☐ No  If yes, specify: ____________ 

Section 3: Experience with Microsoft Word 

• 9. Frequency of use: ☐ Daily ☐ Weekly ☐ Occasionally ☐ Rarely ☐ Never 

• 10. Features used: ☐ Fonts ☐ Tables ☐ Heading Styles ☐ Hyperlinks ☐ TOC ☐ Track Changes 

• 11. Rate your skill level in Word: ☐ Beginner ☐ Intermediate ☐ Advanced 

• 12. Difficult/confusing features? _____________________________________ 

• 13. Main use of Word: ☐ School ☐ Work ☐ Personal ☐ Other: ____________ 

• 14. Version used: ☐ Word 365 ☐ 2019 ☐ Older ☐ Not Sure 

• 15. Use keyboard shortcuts? ☐ Never ☐ Occasionally ☐ Frequently 

• 16. Typical use (e.g. papers, reports, resumes, etc.): ___________________ 

• 17. Used Word for collaboration before? ☐ Yes ☐ No 
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Usability Testing: Microsoft Word 

Follow-Up (Post-Test) Questionnaire 

Section 1: Task Experience 

• 1. Ease of completing tasks: ☐ Very Easy ☐ Easy ☐ Neutral ☐ Difficult ☐ Very Difficult 

• 2. Most difficult/confusing task(s) and why: ___________________________ 

• 3. Easiest or most familiar task(s): _________________________________ 

• 4. Needed more guidance? If yes, when? ____________________________ 

• 5. Any unfamiliar features or terms? ☐ Yes ☐ No If yes, list: __________ 

Section 2: Interface & Design Perception 

• 6. Layout intuitiveness: ☐ Very Intuitive ☐ Somewhat ☐ Neutral ☐ Not Intuitive 

• 7. Any confusing/slowing parts of the design? ☐ Yes ☐ No Explain: ________ 

Section 3: Final Thoughts 

• 8. One thing to improve in Word: _____________________________ 

• 9. Confidence in repeating tasks independently: ☐ Not ☐ Somewhat ☐ Confident ☐ Very 

10. Additional comments/suggestions: ___________________________ 
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Center for Teaching and Learning 
 
Mission 

The Center for Teaching and Learning at UNM collaborates with students, instructors, and staff 
to foster the continued growth of an inclusive community of learners by creating spaces and 
opportunities for reflection and dialogue around evidence-based and learner-centered approaches 
to teaching and learning. By embracing a growth mindset, we aim to listen with compassion and 
meet students and instructors where they are. As a comprehensive team, we strive to create and 
evolve services that meet the educational needs of all Lobos. 

The Center for Teaching and Learning partners with faculty, students, and staff to create 
equitable learning environments that are inclusive, collaborative, and innovative.  

Values 

Student Success 

Every task we do, decision we make, and conversation we have should serve the ultimate goal of 
fostering student success. Faculty and staff are part of the solution to student success. Students 
succeed when they are given the tools, they need to feel confident on their own. 

Cooperation 

We are one team, and we pool our collective expertise and creativity to overcome challenges. 
Our team cooperates beyond CTL, recognizing our part in the larger community, and we 
encourage students, instructors, and staff to work toward common goals. We presume everyone 
is doing their best work and model the culture and behaviors we wish to see across UNM. If we 
don’t understand someone’s behavior, we ask them. 

Growth 

We are all learners, striving to grow as individuals, professionals, academics, and global citizens. 
Growth is not a linear process and involves taking risks. Mistakes are an opportunity for growth, 
allowing for us to build better and more responsive processes. We encourage instructors and 
students to embrace new educational practices and technologies. We incorporate research into 
everything we do and contribute to local, national, and international conversations. 

Equity 

We realize that the university was not designed for everyone, so we are committed to fostering 
and enacting inclusive pedagogies. We challenge preconceptions of strengths and weaknesses 
and educate ourselves on the root causes of educational inequity. We seek to identify and remove 
barriers to access. 

 
 


